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Objectives

d Establish “systems thinking” approach to
IT management

d Understand how the CMMI applies to
different levels of IT systems management

d Examine different interpretations for CMMI
Specific Practices in an IT context
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Agenda
J Introduction

d Setting the context

J CMMI in software teams

d CMMI in infrastructure and operations
teams

d Summary

Page 3
V1.01 December 2002



Introduction

Mark Servello, Vice President
Jim Gibson, Senior Consultant

ChangeBridge, Incorporated

ENGINEERING SUCCESSFUL TRANSITIONS

Page 4
V1.01 December 2002
Copyright © 2002 ChangeBridge, I ncor por ated

Portions Copyright © 2002 Carnegie Mellon University or adapted from such materials
CMMI and SCAMPI are service marks of Carnegie Mellon University.



Assumptions that Confuse
Interpretation

d CMMI applies only to large new systems
development projects

d CMMI is intended only for DoD weapon
system development

d CMMI only directly fits where there is
hardware with embedded software
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What We Will Cover

 Application of systems thinking to IT
organizations

d An approach to understanding CMMI where
the focus is not new systems development

d Interpretation of potentially confusing

Specific Practices in an IT context
» Project Management PAs

» Engineering PAS

» Support PAs

d Three real client cases to illustrate points
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What We Will Not Cover

d Whether the CMMI is better or worse than
the Software CMM

J What is different between CMMI and
Software CMM

d Whether the Staged Representation is
better or worse than the Continuous
Representation
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IT In Context

Strategies
Business Plans

Business |'T Service
Function Delivery

Systems and Services
Technology Capabilities
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Hardware Systems in IT
Components

d Mainframes
d Servers
Desktops
_aptops
Routers
Switches
Hubs
nternet
ntranet
DNS

J Voice Communications
d Cabling
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Hardware Systems in IT
Application Server
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Hardware Systems in IT
Application Server Groups

Server

IBM Compatible

IBM Comyatible IBM Comyatible
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Laptop computer
Laptop computer IBM Compatible
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Hardware Systems in IT
Server Groups

IBM Compatible
IBM Compatible
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Software Systems in IT

d Business Applications
» Financial
> Sales
» Data warehousing
» Personnel
> Internet web

> Intranet web
> ...

d Help desk

d Systems management
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Systems Engineering
Product Life Cycle

| Concept || Definition || Engineering || Operation || Evolution & || Replacement |:
! | Development | | Maintenance || & Disposal |
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Company #1
Internet Service Provider

Vice President - IT
Enterprise . Quality and
Architecture Change Cont

IT
Development
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Company #2
IT Support Contractor

Vice President and

General Manager
Release Systems Enterprise
Management mplementatio Operations

Enterprise
Engineering
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Company #3
Insurance Company

Chief Executive Officer

Insurance Insurance Insurance Infocimgiion
Sector 1 Sector 2 Sector ... Officer

Application Application Application Infrastructure

Development Development Development

Sector 1 Sector 2 Sector ... Support
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Projects COW

Projects COW
Target: Capability Level 1

87
82 81
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41
39 36
%

Nov 2001 Dec 2002

m Proj Planning m Proj Monitoring & Control @ Rgmts Mgmt & Technical Solution
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MWR + Operations COWs
CMMI Rating

BAU
Target: Capability Level 1~ MWR+Operations COWS 100 o
Nov 2001 BAU Dec 2002 Operations
B Proj Planning ® Proj Monitoring & Control CJRgmts Mgmt [ Technical Solution
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All Categories of Work
CMMI Rating

All COWs
Target: Capability Level 1

52

N
(&)}

N
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|

Nov 2001 Dec 2002
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CMMI in Software Teams
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Types of Work

d New system development

 EXxisting system evolution
» Maintenance
» Enhancement
» Replacement

d Vendor management
» COTS
» Custom
» Combination

d System integration
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Project Planning PA
Definitions

4 Project

» Delivery of one or more products to the
customer, with a defined start and end
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Project Planning PA
SP1.1

1 Establish atop-level work breakdown structure
(WBS) to estimate the scope of the project.

d Top level set of tasks, phases, cycles, etc. used to
establish a starting picture of scope

d Project may be a:
» A new system development effort
» A maintenance and/or additional functionality
release
» A COTS integration or implementation
» A combination of the above
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Project Planning PA
SP 1.2

d Establish and maintain estimates of the
attributes of the work products and tasks.

d Attributes of work products
» Counts of items
» Complexity
» Risk

d Attributes of tasks
» Counts of types of task

» Complexity
» Risk
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Project Planning
SP 1.3

 Define the project life-cycle phases upon
which to scope the planning effort.

 Life cycle phases define the major task
synchronization points and how they relate

» Requirements, Design, Code, Integrate, System
test, User acceptance, etc.

> Waterfall

» Spiral

» Evolutionary
> Incremental
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Project Planning PA
SP 1.4

Estimate the project effort and cost for the work
products and tasks based on estimation rationale.

Use SP 1.1 — 1.3, plus rationale, to estimate effort
and cost

d If end date is fixed, adjust scope and resources
d If resources are fixed, adjust scope and end date

d If scope is fixed, adjust resources and end date
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Project Planning PA
SP 2.1

d Establish and maintain the project’s
budget and schedule.

d Budget and schedule are approved based

on

» Estimates

» Review and reconciliation with stakeholders
» Reasonableness of plan
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Project Planning PA
SP 2.2

d Identify and analyze project risks.

d Risks to success of project:

» Product
» Project
» System

d Do not need full risk management at this
point
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Project Planning PA
SP 2.3

d Plan for the management of project data.

O Project data includes:.

» Configuration items

» Internal work products
» Meeting minutes

» Status reports

» Presentations

» Demonstrations

» Etc.

d Planning for project data involves identifying
storage, approval, communication methods
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Project Planning PA
SP 2.4

 Plan for necessary resources to perform
the project.

J Resources include:

» Test labs

» Development equipment
» Facilities

» People
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Project Planning PA
SP 2.6

] Plan the involvement of identified
stakeholders.

d Identify stakeholders
» Users

» Managers
» Others

d Ensure that their involvement points are
Identified in the plan
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Project Planning PA
SP 3.1

d Review all plans that affect the project to
understand project commitments.

 Other plans include:

» Configuration Management
» Quality Assurance

» Infrastructure support

» Stakeholders
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Project Monitoring and Control
d Monitor items identified in Project Planning

d Analyze and take corrective action

1 Manage corrective action to successful
completion
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Project Monitoring and Control PA
SP1.1

d Monitor the actual values of the project
planning parameters against the project
plan.

d Planned vs. actual comparison to

determine progress

» Attributes of work products and tasks
» Effort

» Cost

» Budget

» Schedule
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Supplier Agreement Management

 Suppliers include:

» COTS vendors

» Contracted development and maintenance
» Body shops

» Internal teams

B Infrastructure
B Other product teams

Page 37
V1.01 December 2002



Supplier Agreement Management PA
SP1.1

 Determine the type of acquisition for each
product or product component to be
acquired.

d Types of acquisition

» Internal agreement

» Memoranda of agreement
» Contracts

» COTS

» Staff augmentation

» Custom delivery

» Services
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Supplier Agreement Management PA
SP 1.2

 Select suppliers based on an evaluation of
their ability to meet the specified
requirements and established criteria.

] Established criteria

» Management considerations
» Preferred suppliers
» Company standards
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Requirements Management PA
SP 1.1

 Develop an understanding with the
requirements providers on the meaning of
the requirements.

d Requirements providers include:

» Infrastructure teams

» Corporate architects

» Users and business partners
» System managers

» Vendors
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Requirements Development PA
SP 1.1

 Elicit stakeholder needs, expectations,
constraints, and interfaces for all phases
of the product life cycle.

 Stakeholders include requirements
providers

 Elicitation techniques are those commonly
used for requirements analysis
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Requirements Development PA
SP 1.2

d Transform stakeholder needs,
expectations, constraints, and interfaces
INto customer requirements.

d Output is typically a requirements
specification

» May take many forms
» May evolve during iterative/evolutionary/spiral
phases
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Requirements Development PA
SP 2.1

d Establish and maintain product and
product-component requirements, which
are based on the customer requirements.

d Output is typically a functional description

» May take many forms
» May evolve during iterative/evolutionary/spiral
phases
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Requirements Development PA
SP 3.1

 Establish and maintain operational
concepts and associated scenarios.

d Can take many forms

» Use cases
» Users manuals
» Operating instructions
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Technical Solution PA
SP 1.1

 Develop alternative solutions and selection
criteria.

d For existing systems, typically the

alternative solution space is very limited
» Implementation approaches

» Addition of components

» Custom versus COTS

J Architecture is established
» Options relate to impact of change on existing
architecture
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Technical Solution PA
SP 2.2

] Establish and maintain a technical data
package.

d Technical data package may include

» Evolved use cases

» Design specifications

» Test specifications

» Performance requirements
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Technical Solution PA
SP 2.4

d Evaluate whether the product components
should be developed, purchased, or reused
based on established criteria.

d Make/buy typically applies to new systems
only

1 Reuse may apply in all situations

» Existing code libraries
» Purchased object classes
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Product Integration
SP 1.1

d Determine the product-component
Integration sequence.

d Typically done during test planning

> Integration sequence
» Levels of testing
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Product Integration PA
SP 1.2

d Establish and maintain the environment
needed to support the integration of the
product components.

d Ensure that appropriate test environments
exist

» Development
» System /integration
» User acceptance
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Product Integration PA
SP 1.3

d Establish and maintain procedures and
criteria for integration of the product
components.

 This is test planning

» Test procedures
» Scenarios

» Scripts

» Test data
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Product Integration PA
SP 2.1

d Review interface descriptions for coverage
and completeness.

d Ensure that software component interfaces
are correct
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Product Integration
SP 3.1

d Confirm, prior to assembly, that each
product component required to assemble
the product has been properly identified,
functions according to its description, and
that the product-component interfaces
comply with the interface descriptions.

d Ensure that each component has passed
Its level of review and/or testing prior to
beginning next level of build and test
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Product Integration PA
SP 3.2

d Assemble product components according
to the product integration sequence and
available procedures.

1 Perform the build
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Product Integration PA
SP 3.4

d Package the assembled product or product
component and deliver it to the appropriate
customer.

 Deploy the system into the production
environment
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Verification PA

d Work product reviews on documentary
items to ensure satisfaction of
requirements

 Various levels of testing, most likely
performed as a part of (or driver for)
product integration
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Validation PA
SP 1.1

 Select products and product components
to be validated and the validation methods
that will be used for each.

 Identify the level of component or system
that will be validated in its operational
environment
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Validation PA
SP 1.3

d Establish and maintain procedures and
criteria for validation.

4 Identify how operational testing will be
performed

» Test planning
» Scenarios
» Support mechanisms

d Ensure facilities are available to revert to
prior production versions
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Measurement and Analysis PA

d Addresses mechanisms for managing the IT
software group against a defined set of objectives

d Setting up the program
» Establishing objectives
» Specifying data collection, analysis and
storage mechanisms
» Defining reporting and usage

d Implementing the program
» Measures are typically generated as a part of
B Status reporting
B System evolution
B Business priorities
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The Big Six
Generic, Major Functions of an Operations /
Shared Services Organization

d Platforms

 Operations

d Network

d Voice / Security / Infrastructure Applications
d Configuration / Asset Management

J Customer Service
» Help Desk
» Problem Management)

| mportant Note:
Thisisa generic grouping used solely to facilitate discussion.
Actual organization structure and groupingswill vary.
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Sample Core Services

Platforms Operations Networ k
0 Mainframe QO Batch/Daemon/Job 1O Network
QO Server Queues Engineering
Q0 Desktop U Enterprise Business O Middleware Mgmt
U Mobile and Hand Application Support O Network
held O Backup / Restore Monitoring
Q0 Database O Disaster Recovery
O Internet, Intranet, O Facilities Mgmt
B2B 0 Production Env.
Monitoring
Voice/ Security / Apps Customer Service Config and Asset M gmt
O Voice Engineering / O Help Desk / Call O Asset Mgmt
Apps Center O Configuration Mgmt
O Telephony Support O Problem O Production Env.
O Security Engineering Management Control
O Security Monitoring O Customer Service O Enterprise SW
and Prevention Request Routing Distribution
QO Tools and Internal O Documentation
Applications Support Mgmt
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The Six Functions Span the Workload
Spectrum
(Primary Allocation Shown with solid line)

A

v

Operations/ Shared Services

@
Q
_ >
Projects Reaular / —
Corrective and Preventive Maintenance reguiar /. Event Driven -
Daily Activities o)
Upgrades ;
Platforms
____________________________________________________ c
-------------------------- S
Operations =]
__________________________ -
__________________________ -]
Networ k E"%
- - - N \
Voice/ Security / Infrastructure. Application cmz
_________________________ o)
Help Desk / Problem M anagement
Configuration and Asset M anagement
Page 62

V1.01 December 2002



Consider the Continuum of Work

Forward Thinking vs. Immediate
Delivery

Strategic, Forward Thinking
R& D, New Technologies, Essential Programs

Tactical Action

* Projects
» Service/ Work Requests
e Regular/ Daily Activities
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You Must Understand the Work

Business does not exist in a vacuum, nor do
» Projects

» Software Applications and Products

» |S Operations

1 Each major piece of the continuum has its own
lifecycle
» Tasks
» Decision Points
» Deliverables

O Level of Engineering and Management rigor varies
for each

1 Need for process rigor varies accordingly
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Map the CMMI to the Work - 1

d Projects
» One to one mapping of applicable Process
Areas

d Work requests
» Consider Process Areas as spanning bundles
of work requests

 Daily / Regular Work

» Most effective to map Process Areas across
entirety of the function

» For example, the annual planning for help desk
resources and SLAs is like a “project”
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Map the CMMI to the Work - 2

d Many of the six generic Ops/SS areas have
projects

» Upgrades projects (Database, server, network
components)

» New technology projects (Active Directory,
NET, bringing in LINUX or AlX)

» Migration projects (Sybase to Oracle or vice
versa)

 Projects are easiest to map to CMMI
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d

Map the CMMI to the Work - 3

Use criteria to distinguish project types (“big” vs. “small”)
» New or existing technology
» Effort hours

> Duration
» Cost

Many infrastructure projects have a high cost component
but relatively low effort/risk

» A criteria combining cost/effort works well

Set low end of criteria to distinguish projects

» From Work / Service Requests
» From Regular / Daily Activities

Directly map CMMI Process Areas to your project processes
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Map the CMMI to the Work - 4

d Now we're left with the tougher mapping

» Work / Service Requests
» Regular / Daily Activities

d CMMIis arobust, granular model for projects
» “All models are wrong, some are useful” —
George Box

d CMMI is too granular to apply directly to the
remaining work types, but ...

d ... it can be beneficial to apply CMMI across these
work types
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Well

O Project Management

» Project Planning

» Project Monitoring and Control

» Supplier Agreement Management
» Risk Management

O Engineering

» Requirements Management
» Technical Solution
» Product Integration

O Support

» Configuration Management
» Process and Product Quality Assurance
» Measurement and Analysis
f

SEPG 2003
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Certain CMMI Process Areas Fit

Page 69
V1.01 December 2002



Mapping Discussion

4 Following slides will highlight difficult or
potentially bureaucratic specific practice

mapping

1 Please keep in mind we're talking about
work requests and regular activities

J Format
» Selected Specific Practice (SP) wording and
Intent
» Example(s) of applying the SP to Ops/SS
functions
» Real world issues / recommendations
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Project Planning PA

SP 1.1-1 Estimate the Scope of the Project
» Communicate and agree to scope/schedule/cost triangle

SP 1.2-1 Establish Estimates of Work Product and Task
Attributes
> ldentify key deliverables, milestones and resource/skills
needed

SP 1.3-1 Define Project Life Cycle
» ldentify groupings of major milestones, associated
activities, deliverables and decision points

SP 2.1-1 Establish the Budget and Schedule
» Apply resources, task dependencies, adjust plans to
meet milestones based upon capacity
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YV V VY

Project Planning PA
Mapping

O Operations

Plan resources needed to run batch jobs

Identify and monitor production and maintenance
windows

Plan skills needed to handle production exceptions

Plan resources for printing, stuffing, distribution

Plan for necessary consumables (paper, print cartridges,
tapes)

O Help Desk

>
>

>

Performance SLAS

Usually entails call tracking/problem workflow tool such
as Remedy

Plan for training and cross-training (skills needed to
answer variety of questions)
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Project Planning PA
Recommendations

d Translate “WBS” to “Useful groupings of
work components and associates tasks”

d Plan according to annual budget cycle:
skills needed, anticipated growth, SLAS,
monthly metrics reporting

4 Plan for regular stakeholder
communications
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Project Monitoring and Control PA

d SP 1.1-1 Monitor Project Planning

Parameters
» Objective visibility into progress (scope,
schedule, cost) and re-planning

d Let the workflow toll track individual calls
 Track aggregate performance and trends

 Adjust resources, training and SLAS
accordingly

4 Capture data for future budgeting
Emﬁfﬂmnsf dCoryr i 2002 Changeriage, Incorported V101 December 2002
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Project Monitoring and Control PA
Mapping
d Help Desk

» Execute and monitor metrics against SLAS

» Monitor usage of staff capacity and adjust
staffing

» Problem queue backlog

» Customer feedback surveys
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Project Monitoring and Control PA
Recommendations

] Let the workflow toll track individual calls

 Track aggregate performance and trends

 Adjust resources, training and SLAS
accordingly

1 Capture data for future budgeting
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Supplier Agreement Management PA

d SP 1.1-1 Determine Acquisition Type

» Types of skills needed and why, plan for
oversight needed

d SP 1.3-1  Establish Supplier Agreements
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Supplier Agreement Management PA
Mapping
 Operations

» Printing / Stuffing / Mailing of bills and reports
to customers

» Billing may be performed in-house by different
department or outsourced completely

» Disaster recovery related backup and storage
suppliers
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Supplier Agreement Management PA
Recommendations

d Remember SAM applies to internal and
external suppliers

d Establish appropriate SLAS

d Negotiate appropriate testing and
oversight into activities based upon risk

d Ensure objective performance metrics are
used for management decisions
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Risk Management PA

d SP 1.3-1 Establish a Risk Management
Strategy

» Establish the scope of the risk effort and your
risk taxonomy
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Risk Management PA
Mapping

1 All six functions
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Risk Management PA
Recommendations

d Apply risk management across the entirety
of each function

 Part of the overall organization governance
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Requirements Management PA

d SP 1.1-1 Obtain an Understanding of
Requirements

» Ensure requirements are documented and
agreed by affected groups

d SP 1.4-2 Maintain Bidirectional
Traceability of Requirements

> Be able to demonstrate how intermediate and
final work products satisfy requirements
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Requirements Management PA
Mapping
d Help Desk

» Individuals call events vs. the entire help desk
function
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Requirements Management PA
Recommendations

d The “requirements” of the help desk function:

» Meeting SLAS,

» Call volumes

» Handling surge (e.g., major outage)
» Backlog

d The “requirements” of an individual call are
captured within the workflow tool

 Better value add to apply SPs across the entire
help desk function (vs. an individual call or
problem event)
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Technical Solution PA
Recommendations

d Do not map this process area to smaller
work efforts
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Product Integration PA

d SP 1.1-1 Determine Integration Sequence

» Assemble product components logically and
efficiently

d SP 2.2-1 Manage Interfaces

» Ensure only acceptable disruptions to existing
system/service interfaces
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Product Integration PA
Mapping

d Configuration and Asset Management

» Production Environment Control

Page 88
V1.01 December 2002



Product Integration PA
Recommendations

1 Establish procedures for production
environment control

1 Use standard production migration
procedures across the organization

 Plan ahead: provide regular windows for
production environment changes
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Configuration Management PA

d SP 1.1-1 Identify Configuration Iltems

» Ensure appropriate level of control and
comprehensiveness

d SP 1.3-1 Create or Release Baselines

» Ensure appropriate controls for critical
baselines/environments

d SP 2.1-1 Track Change Requests

» Provide effective and efficient change control
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Configuration Management PA
Mapping

d Configuration and Asset Management

» Changes to production environment, software
distribution/updates

 Operations (Facilities) and Platforms

» New offices, changes to facilities, changes to
existing platform configurations

d Problem Management

» Changes to production environment

Page 91
V1.01 December 2002



Configuration Management PA
Recommendations

 Establish procedures, use automated tools
where possible

 Anticipate need for structured, well
managed verification effort
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Process and Product Quality Assurance PA

d SP 1.1-1 Objectively Evaluate Processes

» Fact based indications of conformance and
performance

d SP 1.2-1 Objectively Evaluate Work
Products and Services

> Similar to 1.1-1
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Process and Product Quality Assurance PA
Mapping

1 All six functions
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Process and Product Quality Assurance PA
Recommendations

1 Classic recommendations:

» Use the right people, focus on the right
priorities

» Apply to critical needs and typically
problematic areas (asset management,
production control, creative platform folks
acting like cowboys)

d Plan for QA across the entire function (all of help
desk)

d Use representative sampling for objective
evidence (actual call events across shifts,

- platform types, etc) :
H age 95
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Measurement and Analysis PA

1 SP 1.1-1 Establish Measurement
Objectives

» Know what you want to measure and why, use
metrics intelligently

Page 96
V1.01 December 2002



Measurement and Analysis PA
Mapping
 Operations

» Batch performance measures, resource
expenditures

d Help Desk

» Call volumes, average response and call times,
backlog data
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Measurement and Analysis PA
Recommendations

 Classic: Understand the needs of the
stakeholders involved and objectives of
measurement program(s)

d Trend over time

d Use metrics for the larger planning and
budgeting cycle
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Summary
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Jim Gibson, Senior Consultant

ChangeBridge, Incorporated

ENGINEERING SUCCESSFUL TRANSITIONS

Page 99
V1.01 December 2002
Copyright © 2002 ChangeBridge, I ncor por ated

Portions Copyright © 2002 Carnegie Mellon University or adapted from such materials
CMMI and SCAMPI are service marks of Carnegie Mellon University.



Summary

d The CMMI is a valid tool for process management
In Corporate IT organizations

d You must understand your system of systems
» Each hardware or software system has a
“product life”
» The evolution of each system is not performed
In i1solation

O You must interpret the CMMI based on
» Organization structure
» Criticality of system
» Type of product or service
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Contact Information

d Mark Servello, Vice President
703-378-0975 voice
Mark.Servello@changebridge.com

J Jim Gibson, Senior Consultant
803-749-0714 voice
Jim.Gibson@changebridge.com
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